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Programming Flow
Figure 19–1 shows the programming file generation flow. This flow covers the types 
of configuration and programming files that are used by the Quartus II Programmer. 
Refer to “Optional Programming Files” on page 19–17 for information on other 
optional programming files.

Table 19–1 shows the programming and configuration file formats supported by 
Altera FPGAs, CPLDs, configuration devices, enhanced configuration devices, and 
serial configuration devices. Chain description files (.cdf) are described in “Chain 
Description File” on page 19–16.

Figure 19–1. Programming File Generation Flow
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Table 19–1. Programming and Configuration File Format

File Format FPGA CPLD

Configuration 
Device and 
Enhanced 

Configuration 
Device

Serial 
Configuration 

Device

SRAM Object File (.sof) v — — —

Programmer Object File (.pof) — v v v

Jam File (.jam) v v v —

Jam Byte-Code File (.jbc) v v v —
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Programming Flow
Figure 19–2 shows the programming flow using the Quartus II Programmer. Refer to 
“Generating Optional Programming Files” on page 19–19 for detailed information 
about converting or creating different programming files. Refer to “Device 
Programming and Configuration” on page 19–12 for information about programming 
or configuring the device.

Figure 19–2. Programming Flow
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Programming and Configuration Modes
The Quartus II Programmer supports the following four programming or 
configuration modes: JTAG, passive serial, active serial, and in-socket programming. 

JTAG Mode
You can use the Joint Test Action Group (JTAG) mode to configure FPGA devices and 
program CPLDs, configuration devices, or enhanced configuration devices. The JTAG 
mode allows multiple FPGAs, CPLDs, and configuration devices connected in a JTAG 
chain to be configured or programmed at the same time. JTAG programming or 
configuration uses four JTAG pins: TCK, TDI, TMS, and TDO. The JTAG interface also 
allows you to perform boundary-scan test using third-party boundary scan tools.

.pof files are used for programming CPLDs, and configuration or enhanced 
configuration devices, while .sof files are used for configuring FPGA devices. .jam 
and .jbc files are used for both programming and configuration. Serial configuration 
devices do not support JTAG programming. 

f For more information about JTAG configuration or programming mode and JTAG pin 
connections, refer to the Configuration Handbook, or the device handbook or data sheet 
for the respective FPGA, CPLD, or configuration device. 

Passive Serial Mode
You can use the passive serial (PS) mode to configure Altera FPGAs. PS configuration 
uses the DCLK, CONF_DONE, nCONFIG, nSTATUS, and DATA0 configuration pins. 
Unlike the JTAG scheme, the PS configuration scheme is used to configure the FPGA 
with a configuration device or enhanced configuration device, not necessarily 
through a download cable. If you use the configuration device or enhanced 
configuration device to configure the FPGA through PS mode, you can route the 
configuration signals out to a header so that you can also configure the FPGA through 
the download cable with the Quartus II Programmer. Configuration through PS mode 
with a download cable is useful in the design stage. This configuration method allows 
you to configure your FPGA device directly from the Quartus II Programmer as you 
make changes to your design for debugging and testing.

PS mode supports configuration of an FPGA chain. .sof files are used for 
configuration through PS mode. Every FPGA device in the chain requires an .sof file, 
so the number of .sof files used depends on the number of FPGA devices in the chain.

f For more information about PS configuration mode and PS pin connection, refer to 
the Configuration Handbook or the chapter on configuration in the appropriate FPGA 
device handbook.
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Active Serial Mode
You can use the active serial (AS) mode to program serial configuration devices. After 
programming is completed, the serial configuration device configures the FPGA. AS 
programming uses the DATA, DCLK, nCS, and ASDI pins. If the download cable is 
connected to the nCONFIG and nCE pins of the FPGA, the download cable disables 
the FPGA’s access to the AS interface by holding the nCE pin high and the nCONFIG 
pin low. Upon completion of the programming, the nCE and nCONFIG pins are 
released and the FPGA configuration begins.

f For more information about programming the serial configuration device, 
configuring the FPGA with the serial configuration device through AS mode, or the 
AS pin connections, refer to the Serial Configuration Data Sheet in the Configuration 
Handbook or the chapter on configuration in the appropriate FPGA device handbook.

In-Socket Programming Mode
The in-socket programming mode is used for programming a single device. This 
programming mode supports programming the MAX® 7000 and MAX 3000 CPLD 
families, configuration devices, enhanced configuration devices, and serial 
configuration devices. Instead of using a download cable, in-socket programming 
mode uses the Altera Programming Unit (APU) hardware together with the 
programming adapter for the corresponding device to program the device. The 
programming unit with the programming adapter has a socket for the device and the 
hardware powers the device for programming. In-socket programming is normally 
used in the production environment to pre-program devices before they are mounted 
on the printed circuit boards on the assembly line.

1 Refer to www.altera.com or the Quartus II Help for a list of programming adapters 
available for Altera devices.

Table 19–2 shows the programming and configuration modes supported by Altera 
devices.

Table 19–2. Programming and Configuration Modes

Mode FPGA CPLD

Configuration Device 
and Enhanced 

Configuration Device
Serial Configuration 

Device

JTAG v v v —

PS v — — —

AS — — — v

In-Socket Programming — v(1) v v

Note to Table 19–2:

(1) MAX II CPLDs do not support in-socket programming mode.
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Programmer Overview
The Quartus II Programmer GUI is a window in which you can add your 
programming and configuration files, specify the programming options and 
hardware, and then proceed with the programming or configuration of the device.

To open the Programmer window, on the Tools menu, click Programmer. Figure 19–3 
shows the programmer GUI. The status of each operation, whether programming is 
successful or not, is reported in the Quartus II message window. Figure 19–4 shows a 
typical programming message after the programmer has successfully programmed a 
device.

Figure 19–3. The Programmer Window

Figure 19–4. Status Report in the Message Window
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Table 19–3 describes the items available in the programmer window.

Table 19–3. Programmer Window Items (Part 1 of 2)

Items Description

Hardware Setup Opens the Hardware Setup dialog box in the programmer and enables you to perform the 
following functions:

■ Add and remove hardware items from the Hardware list

■ Add and remove JTAG servers from the JTAG Servers list

■ Configure your local JTAG server

■ Specify a programming hardware or download cable for device programming and 
configuration

Mode Specifies the programming or configuration mode (either JTAG, In-Socket Programming, 
Passive Serial, or Active Serial Programming).

Progress Shows the progress of a specific operation.

Action Buttons

Start Starts the operations of the specified programming options.

Stop Stops all operations in progress.

Auto Detect Scans the JTAG chain to check for devices in the chain and the chain connection.

Delete Removes the selected programming or configuration files from the programmer.

Add File Adds programming or configuration files to the programmer.

Change File Replaces the selected programming or configuration file with another file.

Save File Allows you to save the data read out from CPLD or configuration devices using the 
“examine” process into a .pof file.

Add Device Adds a device into the JTAG device chain in the programmer. If no programming or 
configuration file is specified, the programmer bypasses this device during programming or 
configuration. You can also add your user-defined device into the chain. 

Up Moves the selected programming/configuration file or device up in the programmer window.

Down Moves the selected programming/configuration file or device down in the programmer 
window.

File or Device Chain Information

File Displays the programming or configuration file name.

Device The Device column shows the following items:

■ The target device of the file, if you add a programming or configuration file into the 
programmer

■ The devices in the JTAG chain detected by the programmer, if you click Auto Detect in 
JTAG mode

■ The device added to the programmer, if you manually add a device into the programmer

Checksum The Checksum column shows the following items:

■ The checksum of the file, if you add a programming or configuration file into the 
programmer

■ The checksum for the data read out, if you examine a device

The checksum is calculated by the Quartus II software. The programmer does not display the 
checksum for the .jam or .jbc files generated for a multi-device JTAG chain.
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Usercode The Usercode column shows the following items:

■ The usercode of the file, if you add a programming or configuration file into the 
programmer

■ The usercode read out from the device, if you examine a device

You can specify the usercode before design compilation, or use the Auto usercode feature 
that uses the checksum as the usercode. The programmer does not show the usercode 
information in PS configuration mode or for the Jam or .jbc files generated for a multi-device 
JTAG chain.

Programming Options

Enable real-time ISP to 
allow background 
programming

Can only be turned on if you are targeting a MAX II device, and is turned off for all other 
device families. When this option is turned on, you can do the real-time in-system 
programming (ISP) for the MAX II device. The existing design in the MAX II device functions 
normally during and after the real-time ISP is completed. The new design starts to function 
after a power cycle to the device occurs.

Program or Configure Can be used for programming CPLDs, configuration devices, or configuring FPGA devices.

Verify Verifies the content of the CPLD and all configuration devices against the respective 
programming files. This option is not available for FPGAs. Verification fails if the data in the 
file is different from the data in the device. Stand-alone verification for the CPLD with the 
programming file used for the programming fails if the security bit is set when the device is 
programmed initially.

Blank-Check Checks whether the CPLD or configuration device is blank. 

Examine Reads back the contents of the CPLD or configuration device. You can then save the 
examined data as a .pof file. Examining a CPLD with the security bit set does not produce a 
usable .pof file. This option is not available for MAX 7000S devices.

Security Bit Protects the design in the CPLD from being examined. If the security bit is set when the 
CPLD is programmed, you cannot read the correct data out using the examine process. 
Security bits cannot be set for the configuration devices or FPGAs.

Erase Erases the contents of the CPLD and all configuration devices. You can also erase the user 
flash memory (UFM) of the MAX II CPLD. This option is not available for MAX 7000S 
devices.

ISP Clamp Allows the MAX II or MAX 7000B CPLD’s I/O pins to be clamped to certain states during 
normal programming. ISP Clamp can only be turned on if certain pins of the device have the 
ISP Clamp State assignment enabled, or you have added an I/O Pin State (.ips) file in the 
programmer.

IPS File Shows the IPS file used for ISP Clamp of the MAX II or MAX 7000B CPLDs. The IPS File 
column only appears if your programmer window has a MAX II or MAX 7000B .pof file. To 
add the .ips file, click once on the row of the programming file and on the Edit menu, click 
Add IPS File. 

Table 19–3. Programmer Window Items (Part 2 of 2)

Items Description
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Table 19–4 shows the programming and configuration options supported by Altera 
devices.

Tools Menu
More programmer options are available from the Tools menu. On the Tools menu, 
click Options. In the Category list, click Programmer. For descriptions of these 
options, refer to Table 19–5.

Table 19–4. Programming and Configuration Options

Option FPGA CPLD

Configuration Device 
and Enhanced 

Configuration Device
Serial Configuration 

Device

Program or Configure v v v v

Verify — v v v

Blank-Check — v v v

Examine — v v v

Security Bit — v — —

Erase — v v v

ISP Clamp — v(1) — —

IPS File (2) — v — —

Real-time ISP — v(3) — —

Notes to Table 19–4:

(1) Only MAX II and MAX 7000B CPLDs support the ISP Clamp feature.
(2) .ips file is used for ISP Clamp.
(3) Only MAX II CPLDs support the real-time ISP feature.

Table 19–5. Programmer Options (Part 1 of 2)

Option Description

Show checksum without usercode Determines whether the checksum values displayed in the programmer are 
calculated with or without JTAG user codes. This option allows you to have multiple 
versions of a programming or configuration file with different user codes, but share 
the same checksum.

Initiate configuration after 
programming

Specifies that configuration devices configure attached FPGA devices automatically 
after the programmer completes programming the configuration devices.

Display message when 
programming finishes

Displays a message when programming or other operation such as examining or 
blank-checking is complete.

Enable real-time ISP to allow 
background programming (for 
MAX II devices)

Can only be turned on if you are targeting a MAX II device. This option is turned off 
for all other device families. When this option is turned on, you can do the real-time 
in-system programming (ISP) for the MAX II device. The existing design in the 
MAX II device functions normally during and after the real-time ISP is completed. 
The new design starts to function after a power cycle to the device occurs.

This option is also available in the programmer window.
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Halt on-chip configuration controller Halts the on-chip auto-configuration controller of the FPGA device for AS 
configuration, or the configuration device for PS or Fast Passive Parallel (FPP) 
configuration to allow JTAG configuration through a download cable. If you want to 
configure your FPGA through JTAG while the FPGA MSEL pins are set to AS mode, 
you should halt the on-chip configuration controller if any of the following 
circumstances occur:

■ The active serial configuration device connected to your FPGA is blank

■ The active serial configuration device is not present

■ An error occurs during AS configuration prior to JTAG configuration

If the MSEL pins are set to PS or FPP mode, halt the configuration controller of the 
configuration device if an error occurs during PS or FPP configuration prior to JTAG 
configuration. The FPGA pulls the nSTATUS pin (which is connected to the OE pin 
of the configuration device) low to disable the configuration device.

Automatically check the 
Program/Configure checkbox when 
adding SOF

Automatically enables the program or configuration operation when adding an .sof 
file to the file list in the programmer window.

Configure volatile design security 
key (for Stratix III/IV devices)

Stratix III and Stratix IV GX devices support both volatile and nonvolatile design 
security keys. Checking this box before programming the key allows the volatile key 
to be programmed into the device.

Use bitstream compression to 
configure devices when available

Some Altera FPGAs support bitstream compression for PS configuration mode. To 
reduce configuration time, this option allows the devices to be configured with 
compressed configuration data from the Quartus II Programmer through PS mode. 

Automatically open as detached 
window

Allows the Quartus II Programmer window to be detached from the Quartus II GUI 
when launched.

Use the enhanced mode Serial Flash 
Loader (SFL) IP for the factory 
default helper image

Allows the Quartus II Programmer to increase the speed of the programming and 
verification by filtering the extra paddings that are introduced by third-party 
programmer tools. In addition, this option increases the speed of programming and 
verification.

Check block CRCs to accelerate 
PFL/SFL verification when available

Reduces the time required to verify the data programmed into a flash device through 
the PFL. This option allows the Quartus II Programmer to verify the flash data by 
checking the cyclic redundancy code (CRC) generated from the data of the 
programming file, as well as of the flash device. 

This option can be used only with PFL designs created with the Quartus II software 
version 8.1 and later.

Table 19–5. Programmer Options (Part 2 of 2)

Option Description
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Hardware Setup
The Quartus II Programmer provides the flexibility to choose a download cable or the 
programming hardware. Before you can program or configure your device, you must 
have the correct hardware setup.

Hardware Settings
Click Hardware Setup to bring up the Hardware Setup dialog box. On the Hardware 
Settings tab (Figure 19–5), you can select a download cable or programming 
hardware available from the Currently selected hardware list. If the download cable 
or programming hardware you require is not displayed, click Add Hardware and 
specify the download cable or programming hardware. Make sure that you have 
installed the download cable driver before adding the hardware. 

1 You do not have to manually add the USB-Blaster™ download cable to the list. After 
installing the driver, simply connect the download cable to the PC before opening the 
Hardware Setup dialog box. The USB-Blaster appears automatically in the list when 
the dialog box is opened.

f More information about programming hardware driver installation is available in the 
Design Software Support page on the Altera website.

JTAG Settings
The JTAG server allows programs such as the Quartus II Programmer to access the 
JTAG hardware. This application software is installed together with the Quartus II 
software. You can also access the JTAG download cable or programming hardware 
connected to a remote computer through the JTAG server of that computer. With the 
JTAG server, you can control the programming or configuration of devices from a 
single computer through other computers at remote locations. The JTAG server uses 
the TCP/IP communications protocol.

Figure 19–5. Hardware Settings
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To view the Hardware Setup dialog box, click Hardware Setup. On the JTAG 
Settings tab (Figure 19–6), you can add or remove JTAG servers from the list. By 
default, you have only the local JTAG server (which is on your computer) in the list. 
By adding a remote JTAG server, you can access the JTAG hardware in that remote 
computer from your computer. You must have the password of the remote JTAG 
server to add the server to your list. Click Add Server, then enter the IP address of 
that computer in the Server name box and the password in the Server password box.

You can also allow remote clients to access the JTAG server on your computer and 
program or configure devices connected to your computer through the JTAG interface 
of your computer. Click Configure Local JTAG Server to enable the server and then 
enter the password that the remote clients require to access your JTAG server.

Device Programming and Configuration
The Quartus II Programmer supports single- or multi-device programming and 
configuration. This section describes the steps required to program or configure 
Altera devices, as well as how to bypass Altera and non-Altera devices in a JTAG 
chain.

Single Device Programming and Configuration
To program or configure a single device with the Quartus II Programmer, perform the 
following steps:

1. On the Tools menu, click Programmer to open the Programmer window.

2. Click Hardware Setup and select the programming hardware or download cable. 
If you are using JTAG mode, you can specify the correct JTAG settings for 
programming or configuration involving remote JTAG servers. 

3. Click Close.

4. From the Mode list, select the programming or configuration mode. 

Figure 19–6. JTAG Settings
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5. Click Add File to add the .pof or .sof file to the programmer (you can omit this 
step if the file is already displayed). To change the file, select it and click Change 
File. To remove the file from the programmer, select it and click Delete. 

1 If you use JTAG, AS, or in-socket programming mode, after the file has been 
added to the programmer, select the programming or configuration option 
by turning on the corresponding check box in the programmer.

6. Click Start.

Multi-Device Programming and Configuration
JTAG and PS modes allow you to program or configure a device chain. A JTAG chain 
can consist of a combination of FPGA, CPLD, and configuration devices that support 
JTAG mode. A PS chain consists of FPGAs that support PS mode. The steps for 
programming or configuring a device chain are similar to the steps for programming 
or configuring a single device. One exception is that in a device chain you must 
specify all the programming or configuration files for the devices you want to 
program or configure. JTAG mode allows you to bypass some of the devices in the 
JTAG chain while programming or configuring the rest of the devices. PS mode does 
not allow you to bypass devices in the FPGA chain.

Bypassing an Altera Device
If you do not want to program an Altera device in the chain, turn off all the options in 
the row of that device. If you do not have the programming or configuration file for 
that device, click Add Device to specify the device.

Bypassing a Non-Altera Device
The JTAG chain you want to program or configure may contain non-Altera devices. 
To program or configure your Altera device in the JTAG chain, you must bypass those 
non-Altera devices. If the non-Altera devices are not in the list of devices that you can 
select, click Add Device in the programmer.
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To bypass the devices, you must manually enter each device name and its JTAG 
instruction register length and JTAG ID code. Click Add Device to open the Select 
Device dialog box. Click New to define a device. In the New Device dialog box 
(Figure 19–7), enter the name of the device and the JTAG instruction register length of 
the device. You can find the JTAG instruction register length in the device’s data sheet. 
You can also specify the JTAG ID code for the device by clicking Add JTAG ID. This is 
optional and you can turn on Allow none to set the ID code to all zeros. If you do not 
specify the JTAG ID code, the default value is all zeros.

Figure 19–7. New Device Dialog Box
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After defining the device, the device appears in the device list (Figure 19–8). Click 
Export to save the information in a Quartus User-Defined Device (.qud) file. This file 
saves the information for the user-defined devices that appear under Device name in 
the dialog box and can be used by other Quartus II projects as well. To obtain 
information on the user-defined devices from the .qud file, click Import and the 
devices are listed under Device name.

Figure 19–8. Select Devices
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Figure 19–9 shows the programmer window for a JTAG chain.

Chain Description File
All the information in the Quartus II Programmer, including the programming or 
configuration mode, programming or configuration files used, device chain 
information, and the programming options specified can be saved in a chain 
description file (.cdf). You do not have to specify the information each time you 
program the device chain. Simply open the .cdf file in the Quartus II software and the 
information appears in the Quartus II Programmer GUI.

Design Security Key Programming
The Quartus II Programmer supports the generation of encryption key programming 
files and encrypted configuration files for Altera FPGAs that support the design 
security feature. You can also use the Quartus II Programmer to program the 
encryption key into the FPGA.

f For more information about using the design security feature with the Quartus II 
software, refer to AN 341: Using the Design Security Feature in Stratix II and Stratix II GX 
Devices and AN 512: Using the Design Security Feature in Stratix III Devices.

Figure 19–9. Multi-Device JTAG Chain
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Optional Programming Files
The Quartus II software can generate optional programming or configuration files in 
various formats to be used with programming tools other than the Quartus II 
Programmer. In addition, you can convert the FPGA configuration files to 
programming files for configuration devices.

Types of Programming and Configuration Files
The Quartus II software generates programming files of various formats for use with 
different programming tools. Table 19–6 shows the programming and configuration 
files generated by the Quartus II software.

Table 19–6. Types of Programming and Configuration Files (Part 1 of 2)

File Format

Generated by the 
Quartus II 
Software

Supported by the 
Quartus II 

Programmer Description

.sof v v
This configuration data file is used for configuring FPGA 
devices. The Quartus II Assembler generates this file when you 
compile your FPGA design.

.pof v v

This programming data file is used for programming CPLDs 
and configuration devices. The Quartus II Assembler generates 
the CPLD .pof file when you compile your CPLD design. The 
configuration device .pof file is converted from the FPGA .sof 
file.

.jam v v

This ASCII-format file is used for configuring or programming 
one or more FPGAs, CPLDs, and configuration devices in a 
JTAG chain. The .jam file includes both programming algorithm 
and data. 

Apart from the Quartus II Programmer, you can use Altera’s 
Jam Standard Test and Programming Language (STAPL) player, 
the quartus_jli executable, or other third-party 
programming tools together with the .jam file. The .jam file is 
also suitable for embedded processor-type programming 
environments.

.jbc v v

Similar to the .jam file, this binary-format file is used for 
configuring or programming one or more FPGAs, CPLDs, and 
configuration devices in a JTAG chain. The .jbc file includes 
both the programming algorithm and data, and the size is 
smaller than the .jam file.

In addition to the Quartus II Programmer, you can use Altera’s 
Jam Byte-Code player, the quartus_jli executable, or other 
third-party programming tools together with the .jbc file. The 
.jbc file is also suitable for embedded processor-type 
programming environments.

Serial Vector 
Format File 
(.svf)

v —

This ASCII-format file is used for configuring, programming, 
blank-checking, and verifying one or more FPGAs, CPLDs, and 
configuration devices in a JTAG chain. The .svf file, which 
includes programming algorithm and data, is suitable for an 
automated test equipment (ATE) environment that requires a 
fixed programming algorithm.
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f Refer to the Quartus II Help or the Configuration File Formats chapter of the 
Configuration Handbook for more information about the programming and 
configuration file formats.

f For more information about using the .jam and .jbc programming files with the Jam 
STAPL Player, Jam STAPL Byte-Code Player, and the quartus_jli command-line 
executable, refer to AN 425: Using Command-Line Jam STAPL Solution for Device 
Programming.

In-System 
Configuration 
File (.isc)

v —

This data file is used with the IEEE 1532 BSDL file for 
programming a single device that supports IEEE 1532 
programming.

The Quartus II software supports the .isc file for MAX 7000AE, 
MAX 7000B, and MAX 3000A CPLDs.

Hexadecimal 
Intel-Format 
Output File 
(.hexout)

v —

The .hexout file is used for programming FPGA configuration 
data into enhanced configuration devices or other storage 
devices. For enhanced configuration devices, use the enhanced 
configuration device .pof file to generate the .hexout file. Use 
the FPGA .sof file to generate the .hexout file for other storage 
devices (for example, the flash or EEPROM devices). You can 
use a microcontroller to read back the data from the storage 
device and configure the FPGA.

To program the enhanced configuration device or other storage 
devices with the .hexout file, you can use other third-party 
programming tools. 

Raw Binary 
File (.rbf) v —

This binary file contains configuration data for one or more 
FPGAs. You can use Microblaster or Altera’s JRunner software 
to configure your FPGA device with the .rbf file. The .rbf file is 
also suitable for embedded processor configuration 
environments.

Tabular Text 
File (.ttf) v —

This ASCII file contains configuration data for one or more 
FPGAs. The .ttf file is used for embedded processor-type 
configuration.

Raw 
Programming 
Data (.rpd)

v —

This binary file is used for programming serial configuration 
devices. Use the serial configuration device .pof file to generate 
this file. You can use Altera’s SRunner software to program 
your serial configuration device with the .rpd file.

JTAG Indirect 
Configuration 
File (.jic)

v v
The .jic file is used for programming serial configuration 
devices through JTAG with the Quartus II Programmer and 
Altera FPGAs that support AS configuration mode.

Table 19–6. Types of Programming and Configuration Files (Part 2 of 2)

File Format

Generated by the 
Quartus II 
Software

Supported by the 
Quartus II 

Programmer Description
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Flash Loaders
Generating Optional Programming Files
When you compile your design, the Quartus II Assembler generates the .sof file for an 
FPGA or a .pof file for a CPLD. With the .sof or .pof file for your design, you can then 
create other optional programming or configuration files, or convert the .sof file to 
target a particular configuration device.

Create Programming Files
The Quartus II software allows you to create .jam, .jbc, .svf, or .isc programming or 
configuration files. In addition, you can create .jam, .jbc, and .svf files for a JTAG 
chain that consists of more than one device.

To create the files, open the Quartus II Programmer, set the programming or 
configuration mode to JTAG, and then add the programming or configuration files or 
devices to the programmer. On the File menu, click Create/Update and then click 
Create JAM, SVF, or ISC File. Select the file format and name the file accordingly.

An .svf file can only be created for programming or verification. In addition, you can 
specify whether or not to do the optional blank-check operation with the .svf file.

Convert Programming Files
To store the FPGA data into configuration devices, you can convert the .sof data to 
another format and program the configuration device. The Quartus II software 
supports converting the data into .pof, .hexout, .rbf, .ttf, .rpd, or .jic format.

f For more information about converting programming files with the Quartus II 
software, refer to the Configuration File Formats chapter of the Configuration Handbook.

Generating Optional Programming or Configuration Files During Compilation
The Quartus II software can generate optional programming or configuration files 
automatically when you compile your design. To select the format of the optional 
programming or configuration files to be generated during compilation, on the 
Assignments menu, click Settings. Under Device, click Device and Pin Options.

You can select the configuration device from the Configuration tab for the .pof file 
generation. For other optional programming and configuration file generation, you 
can select the file format under the Programming Files tab.

Flash Loaders
Serial configuration devices and the common flash interface (CFI) flash devices do not 
support the JTAG interface and cannot be programmed directly through the normal 
JTAG programming. Flash loaders allow the programming of the serial configuration 
device and the CFI flash from the Quartus II Programmer through JTAG.

Parallel Flash Loader
The parallel flash loader (PFL) performs two functions:

■ Allows the programming of the CFI flash through the JTAG interface

■ Acts as the configuration controller that reads the configuration data from the CFI 
flash and configures the FPGA
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To program the CFI flash, the PFL uses the MAX II device as a bridge between the 
JTAG interface of the Quartus II Programmer and the CFI of the CFI flash device. You 
can program FPGA configuration data and user data into the flash with a flash .pof 
file generated by the Quartus II software. After the flash is programmed with the 
FPGA configuration data, the PFL is then used to read the configuration data back 
from the CFI flash to configure the FPGA.

f For more information about the PFL, refer to AN 386: Using the MAX II Parallel Flash 
Loader with the Quartus II Software.

Serial Flash Loader
The serial flash loader (SFL) allows programming of the serial configuration devices 
through JTAG. The SFL uses the FPGA device that supports AS configuration mode as 
a bridge between the active serial memory interface (ASMI) of the serial configuration 
device and the JTAG interface of the programmer. The Quartus II Programmer uses 
the .jic file converted from the FPGA .sof file to program the serial configuration 
device though JTAG.

f For more information about the SFL, refer to AN 370: Using the Serial Flash Loader with 
the Quartus II Software.

JTAG Chain Debugger Tool
The JTAG Chain Debugger tool is a Quartus II Programmer feature that allows you to 
test the JTAG chain integrity and detect intermittent failures of the JTAG chain. In 
addition, the tool allows you to shift in JTAG instructions and data through the JTAG 
interface as well as stepping through the test access port (TAP) controller state 
machine for debugging purpose.

To launch the JTAG Chain Debugger, open the Quartus II Programmer. From the 
Processing menu, click JTAG Chain Debugger. The Quartus II programmer also 
prompts you to launch the JTAG Chain Debugger if the Auto Detect operation fails to 
detect the device chain.

The JTAG Chain Debugger GUI is divided into two sections: the JTAG Chain Integrity 
section and the JTAG Chain Debugging section.
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JTAG Chain Debugger Tool
JTAG Chain Integrity 
From the JTAG Chain Integrity tab in the JTAG Chain Debugger tool, you can 
perform the JTAG chain integrity test and the IDCODE iteration test. Figure 19–10 
shows the JTAG Chain Integrity tab in the JTAG Chain Debugger tool.

Figure 19–10. JTAG Chain Integrity Tab
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JTAG Chain Integrity Test
The JTAG chain integrity test performs a simple test to ensure that there is tDO-to-tCO 
connectivity for the JTAG chain under test. When you click the Test JTAG Chain 
button, the tool attempts to read out the 32-bit IDCODE of the device or devices in the 
chain. If the JTAG chain connection is good, the device IDCODEs are shifted out from 
the chain through the TDO output. The Device chain box displays the device or 
devices detected in the chain based on the IDCODEs shifted out, and the Session log 
message box reports the test result. Figure 19–11 shows that the tool has detected 
three devices in the JTAG chain and the connection is good.

The IDCODE of the device cannot be shifted out through the chain if one or both of 
the following two circumstances exist:

■ There is a connection problem between the TDO pin of a device in the chain and the 
TDI pin of the subsequent device in the chain (in which case the connection might 
be open)

■ The device has TCK or TMS connection problems

Figure 19–11. Good JTAG Chain Connection
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The tool can detect only the subsequent devices in the chain and report the potential 
problems in the chain. Figure 19–12 shows that the tool detects only two devices in the 
chain, and the first device in the chain has a connection problem. 

Figure 19–12. Incomplete JTAG Chain Detected
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